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Clearance of fused synaptic vesicle components and availability of release sites are important

determinants of recovery from short-term synaptic depression. However, the dynamics of release

site clearance are not well established. This protocol illustrates single-molecule imaging of an

exocytosis reporter, synaptophysin-pHluorin fusion protein (SypHy), by combining two-color

laser scanning confocal microscopy with whole-cell patch-clamp recording of retinal bipolar cells

from transgenic zebrafish that weakly express SypHy to track the dynamics of newly fused vesicle

proteins at the active zone.
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SUMMARY

Clearance of fused synaptic vesicle components and availability of release sites
are important determinants of recovery from short-term synaptic depression.
However, the dynamics of release site clearance are not well established. This
protocol illustrates single-molecule imaging of an exocytosis reporter, synapto-
physin-pHluorin fusion protein (SypHy), by combining two-color laser scanning
confocal microscopy with whole-cell patch-clamp recording of retinal bipolar
cells from transgenic zebrafish that weakly express SypHy to track the dynamics
of newly fused vesicle proteins at the active zone.
For complete details on the use and execution of this profile, please refer to Vai-
thianathan et al. (2019).

BEFORE YOU BEGIN

Synapses of visual and auditory sensory neurons are specialized functionally and morphologically to

faithfully encode a wide dynamic range of signals, while enhancing the detection of spatial or tem-

poral changes in stimulus intensity (Matthews and Fuchs, 2010; Moser et al., 2020). For synapses that

transmit tonically, the limiting factor for sustained transmission is the availability of fusion sites to

which synaptic vesicles can dock rather than the sheer number of synaptic vesicles (Neher, 2010).

Due to technical constraints, the kinetics for clearance of newly fused synaptic vesicle proteins

from the active zone have remained unclear. An ideal approach for investigating the dynamics of

nanodomain synaptic vesicles is the simultaneous labeling of synaptic vesicles and active zone-spe-

cific proteins in the living synapse that can be stimulated to release using physiological relevant stim-

uli and visualized by high spatiotemporal resolution imaging (Vaithianathan et al., 2016). Synapses of

retinal bipolar cells (BPCs) and other sensory neurons that release neurotransmitter continuously in

response to graded changes in membrane potential rely on the proper function of a specialized

organelle, the synaptic ribbon, which is a complex molecular structure that tethers synaptic vesicles

to the cytomatrix at the active zone (CAZ) (Matthews and Fuchs, 2010; Moser et al., 2020; Schmitz

et al., 2000). A well-established method for localizing synaptic ribbons is to label them with fluores-

cent ribeye-binding peptide (RBP) (Vaithianathan et al., 2016, 2019; Zenisek et al., 2004). However,

monitoring the trafficking, fusion, and clearance of synaptic vesicles remains technically challenging.

The conventional procedure involves labeling of synaptic vesicles with FM dye and imaging them

using total internal reflection fluorescence microscopy (TIRFM). However, because FM dye labels

multiple vesicles and does not serve as a reporter of exocytosis, this procedure cannot be used to

track the clearance of fused synaptic vesicles. Instead, we have developed the novel and unique
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technique described here, which is an assay based on our recently established transgenic zebrafish

line that weakly expresses the exocytosis reporter, synaptophysin-pHluorin fusion protein (SypHy)

(Vaithianathan et al., 2016, 2019). The sparse expression of SypHy in this line allows us to detect sin-

gle fusion events in situ. When combined with high spatiotemporal-resolution imaging and labeling

of the synaptic ribbon with RBP to provide a roadmap to the specific location of fusion with respect to

the CAZ, this method allows us to determine the kinetics of synaptophysin protein clearance from a

single synaptic vesicle within the ribbon active zone. The protocol is divided into the following sec-

tions, based on the temporal order (timing) of the experimental procedures. All animal studies were

approved by the University of Tennessee Health Science Center (UTHSC) Institutional Animal Care

and Use Committee (IACUC) and performed in accordance with the guidelines.

Prepare transgenic zebrafish as a source of retinal cells for the experiments

Timing: 2–3 weeks; start at least 5–6 months before the experiment

1. Set up crosses of the SypHy transgenic zebrafish line.

a. Please refer to (Vaithianathan et al., 2016) for details about the development of the SypHy

transgenic zebrafish line. For detailed procedures for crossing of zebrafish, please refer to

the website https://zfin.org/zf_info/zfbook/chapt2/2.7.html.

b. The transgene expresses a cardiac marker that is fused to GFP, which allows the sorting of em-

bryos that possess a GFP-positive heart.

Note: Larger fish possess larger retinas and therefore provide an improved yield of isolated

bipolar cells in the procedure entitled, ‘‘Isolation of bipolar cells from zebrafish retinas.’’ Hous-

ing zebrafish at lower density increases their size.

Prepare solutions necessary for experimental procedures

Timing: 3 h; prepare less than 2 weeks before the start of the experiment and store at

�20oC where indicated.

2. Prepare 0.5 mM Ca2+ HEPES buffer.

a. Refer to the Materials and Equipment section for recipe and preparation instructions.

3. Prepare 2.5 mM Ca2+ HEPES buffer (Recording Solution).

a. Refer to the Materials and Equipment section for recipe and preparation instructions.

4. Prepare Intracellular/Pipet Solution.

a. Refer to the Materials and Equipment section for recipe and preparation instructions.

5. Prepare RBP-Cy5 stock solutions and store at �20oC.

a. Custom-made peptide containing the ribbon binding sequence and an amino-terminal

cysteine (EQTVPVDLSVARPR) fused to Cy5 were synthesized, purified, and purchased from

LifeTein Peptide (>95% purity).

b. Dissolve the entire vial of RBP-Cy5 in DMSO to 2.5 mM and divide into 1.4 mL aliquots in 0.5-

mL non-stick RNase-free microfuge tubes.

c. The stock preparation of peptide can be stored for several weeks at �20�C.
6. Prepare hyaluronidase enzyme stock solution and store at �20oC.

a. Make 503 stock and divide into 10 mL aliquots in 0.5-mL non-stick RNase-free microfuge

tubes.

b. The stock can be stored for several weeks at �20�C

Note: Each batch of hyaluronidase varies in the number of units per mg supplied by the manu-

facturer. Prepare stock solutions to achieve a final of 1,100 units/ml in 0.5 mM HEPES buffer.

7. Prepare DL-Cysteine stock solution and store at �20oC.
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a. Prepare 603 stock solution in DI H20 and divide into 5 mL aliquots in 0.6-mL microfuge tubes.

b. The stock can be stored for several weeks at �20�C.

Prepare for isolation of bipolar cells from transgenic zebrafish

8. Prepare the glass-bottom recording chambers.

Timing: 3–4 h; prepare at least one week prior to the experiment

For each chamber:

a. Drill a (�1/2’’) hole in the lid of a 35 mm culture dish.

b. Using Super Fine (400 grit) silicon carbide sandpaper (we use 3M�Wetordry�), sand the top

and bottom sides of the lid around the drilled hole to smooth the surface and to prepare the

site for attachment of the coverslip.

c. Wash and dry the drilled tops by washing and soaking overnight in DI water and allow to air

dry.

d. Attach a coverslip (Carolina Biological Supply) with adhesive to the bottom side of the pre-

pared lid. We use SYLGARD 184 for this purpose. Mix base and curing agent of SYLGARD

184 and apply evenly with wooden spatula at the bottom of the dish around the hole. Place

the cover slip so that it covers the hole and press the coverslip firmly to make a tight seal.

Please see Methods video S1.

e. Air dry or use heat to cure the SYLGARD 184 as per the manufacturer’s instructions.

f. Wash and dry the resulting glass bottom recording chambers before plating the cells.

Note: Use gloved hands when working with SYLGARD and change to a clean pair of gloves to

place the coverslip. Apply only a very thin coat of SYLGARD, as the excess can seep through

the coverslip.

9. Prepare fire-polished glass triturates for use in preparing the retinal bipolar cells.

Timing: 15 min; prepare at least one day before performing the experiment

a. Use the flame of a Bunsen burner to smooth the tip of one 5 3/4-inch glass Pasteur pipet for

each triturate.

b. Because the duration of flaming is proportional to the size of the resulting tip, vary the duration

to prepare several triturates with different bore sizes.

c. If an angle is desired, use heat at the position slightly bend near the tip, for example � 1/2’’

above the tip. Please see Methods video S2.

Note: The desired triturate bore size can be estimated from the size of the zebrafish retina.

The larger bore size should be equal or little smaller than the piece of retina to be triturated.

The medium and smaller should follow the same approach, i.e., smaller than the triturated

piece of retina. The bore should not be much larger or smaller than the piece of the retina

to be triturated.

10. Prepare patch pipet filler.

Timing: 10 min; to be completed at least one day before the experiment

Flame 1mL syringe tip to prepare fresh/clean fillers for each experiment.

11. Heat-shock the transgenic zebrafish to induce transgene expression.
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Timing: 2 h; to be completed approximately 14 h before the experiment

a. Expression of the SypHy transgene is regulated by the HSP70 heat shock promoter. There-

fore, the transgenic zebrafish must be subjected to heat shock by placing them in a 37 G

2�C water bath for two hours.

b. The heat shock is performed on one day and the experiment is performed the day after,

approximately 14 h. later, to allow sufficient time for protein expression.

Note: All animal studies were approved by the University of Tennessee Health Science Center

(UTHSC) Institutional Animal Care and Use Committee (IACUC) and performed in accordance

with the guidelines.

12. Adapt zebrafish to the dark to facilitate preparation of the retinal cells.

Timing: 2 h; on the day of the experiment

a. Place an adult zebrafish in its tank into a dark adaptation station, for example, incubator or an

oven set at 28�C–30�C.
b. Place an aquarium bubbler (air stone) into the tank and close the lid.

c. Cover the dark adaptation station with black cloth and allow the fish to adapt for 2 h.

Note: Adapting zebrafish to the dark prior to the experimental procedure helps to separate

the retinal pigment epithelium from the retina during dissection.

Isolation of bipolar cells from zebrafish retinas

Timing: 1.5 h; on the day of the experiment

13. Dissection of the retina.

a. Clean a new double-edged coated blade (EMS) with 70% EtOH to remove the grease cover

and rinse with DI H2O.

b. Anesthetize the dark-adapted zebrafish with tricaine (20–30 mg/L of MS-222, buffered to pH

of 7.0–7.5) or immobilize it by submersing in cold water.

c. Euthanize the fish by quick decapitation with the prepared double-edged blade.

d. Remove the eyes by slowly pulling them out of their sockets and cutting the optic nerve with

McPherson-Vannas micro-dissection spring scissors.

e. Place the eyes in a small petri dish (35 mm) with oxygenated 0.5 mM Ca2+ HEPES buffer at

room temperature.

The following steps are done under Stereoscope (Olympus SZX16 Wide Zoom Versatile Ste-

reo/fluorescent Microscope, tilting trinocular observation) in oxygenated 0.5 mM Ca2+

HEPES buffer at room temperature.

f. Puncture the cornea with a disinfected micro-needle and remove the anterior segment by

cutting through the scleral limbus. Puncturing the cornea will release the bounciness of the

eye and serve to stabilize the eyecup for dissecting the retina.

g. Cut the optic nerve and remove the sclera by placing the scissors between the sclera and

retina.

h. Cut the retina into quadrants and rinse it in oxygenated 0.5 mM Ca2+ HEPES and incubate in

hyaluronidase solution for 20 min.

Note: Please refer to (Joselevitch and Zenisek, 2009) for more details on retina dissection and

bipolar cell isolation. All animal studies were approved by the UTHSC IACUC and were per-

formed in accordance with the guidelines.
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14. Perform enzymatic digestion of the retina and plate the bipolar cells.

a. Prepare fresh digestion solution by combining 2–7 mM cysteine and 20–30 units/mL papain

(the number of units per unit volume depends on the source and lot number of the papain

stock) in oxygenated 0.5 mM HEPES.

b. Wash the hyaluronidase-treated retina at least three times and transfer to prepared digestion

solution (step 14a) and incubate it at room temperature for 25–45 min.

c. Rinse several times with oxygenated 0.5 mM Ca2+ HEPES solution.

d. Triturate the retinal pieces in oxygenated 0.5 mM Ca2+ HEPES solution using fire-polished

glass pipets (prepared in step 9).

e. Three trituration steps are sufficient to liberate cells if the digestion is complete. The solution

with isolated cells will turn cloudy, which can indicate that the digestion is complete.

(Methods video S3) See Troubleshooting, problem 1.

f. Plate the cells in a clean glass-bottom dish (prepared in step 8) and allow them to adhere for

30 min at room temperature.

g. Replace 0.5 mM Ca2+ HEPES with 2.5 mM Ca2+ HEPES before recording. Exchange of solution

must bedone slowly andgently so as not todisturb the cells that are adhered to the glass bottom.

Prepare equipment for SypHy imaging

This procedure involves steps that will allow the acquisition of synchronized electrophysiological and im-

aging data, using patch clamping and laser scanning confocal microscopy. We collect electrophysiolog-

ical data using a HEKA patch clamp amplifier running PatchMaster Next multi-channel data acquisition

software (HEKA Electronik, Harvard Bioscience, Inc., Holliston, MA). Imaging data will be collected using

a laser scanning confocal microscope. We use an Olympus model IX 83 motorized inverted FV3000RS

microscope running FluoView FV3000 software (Olympus, Center Valley, PA).

Timing: 3–4 h.; any time before the experiment

15. Confirm that there are no vibrations by imaging a fixed fluorescent bead using x-t line scans. See

Troubleshooting, problem 2.

16. For Differential Interference Contrast (DIC) by eye and laser, insert the DIC main prism slider

below the nose piece and properly adjust the cross-Nicol. Select DIA and DIC settings in the

FluoView software.

17. If a non-sequential scan is used for imaging, it is critical to check for any crosstalk or bleed-

through between fluorophores. This is performed by imaging each channel with both lasers, us-

ing the parameters for imaging bipolar cells isolated from wild-type (WT) zebrafish.

a. We typically test for crosstalk from the RBP channel (LD 647) to the SypHy channel (LD 488),

as follows. Perform whole-cell patch-clamp recording in freshly isolated retinal bipolar cells

(Step 4, under the step-by-step method ‘‘localize single ribbon active zone and track a single

SypHy molecule.’’) with intracellular (pipette) solution (Step 4, ‘‘Prepare solutions’’ under the

before you begin and Step 2, under the step-by-step method details) containing RBP-Cy5

(Step 5, ‘‘Prepare solutions’’) to mark synaptic ribbons, collect line-scan images with LD

647 and 488, and analyze the images in the same manner that will be used for experiments.

b. To test for possible crosstalk from the SypHy channel to the RBP channel, we image GFPmol-

ecules fixed to the same glass bottom dish in both LD 647 and 488.

c. Optimally there should be no bleed-through between channels. If there is any bleed-

through, sequential scanning should be performed instead of non-sequential scanning.

18. Examine for photobleaching by performing x-t line scans of immobilized GFP using the exper-

imental imaging parameters.

a. We use a fast scan speed (2–10 ms/pixel), low laser intensity (0.5–1 mW), and low pixel density

(frame size, 256 x 256 pixels) to minimize photobleaching and phototoxicity during live-cell

imaging.

b. The photobleaching rate can be calculated directly or by using an exponential fitting equa-

tion, ðy0 = Aexpf� ðx � x0Þ =tgÞ.
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19. Measure the point spread function (PSF) of the microscope using full width at half maximum

(FWHM).

a. We obtain lateral and axial point spread function by taking an XYZ scan through a single 27-

nm fluorescent bead. The point spread is governed by the wavelength of imaging light used

for imaging and the numerical aperture of the objective lens.

b. Please refer to (Vaithianathan and Matthews, 2014) for the fitting details and measurement of

FWHM.

Note: Steps, 15–19 are performed once before the experiments begin, to establish the pa-

rameters required for single molecule imaging. Unless changes are made or observed during

steps 15–19, there is no need to repeat these steps every time the experiments are performed.

20. Set up laser scanning confocal microscope and patch clamp apparatus.

Timing: 30 min; on the day of the experiment

a. Turn on FV3000RS microscope and HEKA patch clamp amplifier and open Olympus FV3000

and HEKA PatchMaster software, as per the manufacturers’ instructions.

b. To synchronize imaging and voltage clamp stimuli, we use an FV30-Analog box and activate the

respective channels in Patch Master and Fluoview software. This can be achieved as follows:

i. Connect the jack labeled Trigger IN on the Olympus FV30-Analog box to the HEKA

amplifier jack labeled Trigger OUT and connect the Analog box jack labeled Trigger

OUT to the HEKA amplifier input jack labeled Trigger IN. This will allow the exchange

of electrical logic pulses between the patch-clamp and imaging computers to facilitate

synchronized acquisition of electrophysiological and imaging data.

ii. In the FluoView software, activate the Trigger window, which will allow the instrument to

respond to the transistor-transistor logic (TTL) trigger. Set up the PatchMaster protocol

generator file (PGF) to define the timing of the TTL pulse. Further details of the setting

of PGF parameters can be found in the instruction manual from HEKA Electronics at

https://www.heka.com/downloads/software/manual/m_patchmaster.pdf.

iii. To obtain precise timing of imaging relative to voltage-clamp stimuli, connect the analog

box jack labeled TRAC to the HEKA amplifier jack labeled AD to allow the PatchMaster

software to digitize horizontal-scan sync pulses from the imaging computer in parallel

with the electrophysiological data.

iv. Turn on the OUTPUT channel in the FluoView Trigger window and activate the analog to

digital converter (AD) channel in PatchMaster PGF.

21. Turn on the manipulator.

22. Prepare the electrode holder and attach a mouthpiece to its tube connector to allow the oper-

ator to apply positive and negative pressure.

23. Set the correction collar for the thickness of the coverslip used in preparing the homemade

glass-bottom recording chambers.

KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER

Chemicals, peptides, and recombinant proteins (Enzymes)

NaCl Fisher Scientific S271-3

KCl Fisher Scientific P217-500

CaCl2 Honeywell / Fluka 21117-1L

MgCl2 Fisher Scientific AM95305

HEPES J.T. Baker 4018-04

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

TEA-Cl Tocris Bioscience 3068

Glucose Sigma-Aldrich G5146

Cesium hydroxide Acros Organics 213601000

Cesium Gluconate Hello Bio, Incorporation HB4822-10g

NMDG Sigma-Aldrich M2004-500GM

EGTA EMD Millipore 324626-25GM

Na2-ATP Fisher Scientific BP413 25

Na-GTP Fisher Scientific 10106399001

Hyaluronidase, type V Sigma-Aldrich H6254

Papain Fluka 76220

DL-Cysteine Fluka 30197

Glutathione Sigma-Aldrich 3541-25GM

Cy-5 RBP LifeTein 36408

3-aminobenzoic acid ethyl ester methanesulfonate
(Tricaine)

Sigma-Aldrich 5040

Experimental models: Organisms/strains

Zebrafish: Transgenic zebrafish that express SypHy
(synaptophysin-pHluorin fusion protein) under control of
heat-shock promoter (adult, male or female)

(Vaithianathan et al., 2016) https://zfin.org/action/feature/view/
ZDB-ALT-160602-11#summary

Software and algorithms

FV3000 FV31S-SW, version: 2.3.1.163 Olympus n/a

pCLAMP 10.2 software, version: v2x90.4 Molecular devices n/a

Igor Pro 8, version: 8.04 Wavemetrics n/a

Fiji/ImageJ, version: 2.1.0/1.53c (Schindelin et al., 2012) n/a

Adobe Photoshop, version: 22.4.3 Adobe n/a

EndNote X9.2 Clarivate n/a

Other

FV3000-RS inverted microscope Olympus FV3000

Silicon oil-immersion objective lens (magnification 603) Olympus SIL300CS-30CC

Patch-Clamp Amplifier HEKA EPC 10 USB

Analog box Olympus FV30-Analog

Horizontal electrode puller Sutter Instrument P-1000

Microfuge MDI Inc. MFG-5A

Manipulator Siskiyou MC1000e-R/T Controller

Anti-vibration table Kinetic Systems 9101-50-46

Osmometer Elite Group Model 5600

Thick-walled borosilicate glass tubing (outer diameter:
1.5 mm, inner diameter: 0.86 mm)

Sutter Instrument BF150-86-10

Fine Forceps – Dumont #5 Fine Science Tools 11254-20

Vannas Spring Scissors – Microserrated Fine Science Tools 15007-08

Sample cups – 0.5 and 1 ml VWR Scientific 15070-293

Culture dishes Falcon 353001

Coverslip Fisher Scientific 125485EP

Pasteur pipettes Fisher Scientific 03-678-20A

50 ml Falcon tube Fisher Scientific 352070

0.5-ml Non-Stick RNase-Free microfuge tubes Fisher Scientific AM12350

Water bath set at 38.5 C Precision 282

Oven set at 28.5 C (satellite house) Fisher Scientific IsoTemp Oven

Thermometer VWR 80501

Timer Fisher Scientific 06-662-5

Bubbler and lighting for zebrafish satellite housing Amazon B07XBSY32G

35 mm tissue culture dish Fisher Scientific 50-809-252

Coverslip for glass bottom dish Carolina 633075

(Continued on next page)
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MATERIALS AND EQUIPMENT

Laser scanning confocal microscope

We use an Olympus model IX 83 motorized inverted FV3000RS microscope running FluoView

FV3000 software (Olympus, Center Valley, PA) and equipped with a 603 Silicon objective (NA

1.3), all diode laser combiner with four laser lines (405, 488, 561 & 640), a true spectral detection sys-

tem, a hybrid galvanometer, and a resonant scanning unit.

Patch-clamp instrument setup

We collect electrophysiological data using a HEKA patch clamp amplifier running PatchMaster Next

multi-channel data acquisition software (HEKA Electronik, Harvard Bioscience, Inc., Holliston, MA).

Please refer to the user manual for Patch Master Next software (link in Step 20b) and training for

proper assembly of the apparatus and setup of the software.

Pipet puller

We use a P-1000 horizontal pipet puller (Sutter Instrument Company, Novato, CA), which has several

parameters that must be specified. We follow the general lookup table for borosilicate glass (item

number BF 150-86-10) and select the Type A program for patch and extracellular recording. We

modify the heat parameters (ramp +10–20) to obtain a tip opening that is approximately the desired

size.

Microforge

We use an MFG-5 microforge-grinding center (Warner Instruments, Holliston, MA) for fire polishing.

During the protocol, the size of the pipet opening is observed using the attached microscope, which

is equipped with low (103) and high (403) magnification for long distance air objectives.

Note:Coat the pipet with a hydrophobic insulator such as dental wax to decrease capacitance

and improve noise characteristics (see "Prepare patch-clamp pipettes,’’ in step 3d under step-

by-step method details for this technique).

Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

SYLGARD(R) 184 Sigma-Aldrich 761036-5EA

Dental wax Kerr 09240

Sandpaper Amazon 3M-Wetordry 400 Super Fine

Double-edged coated blade EMS 72000

Fluorescent beads (https://www.thermofisher.com/
search/browse/category/us/en/90220126/microspheres?
filter=dimDiameterMetric_dim_ss%3A0.02%20%26mu%
3Bm)

Thermo Fisher Scientific F8760 (Suggestion/alternative material)

0.5 mM calcium (Ca2+) HEPES

Reagent (stock concentration) Final concentration (mM) Amount

NaCl (3M) 120 40 mL

KCl (1M) 2.5 2.5 mL

CaCl2 (1M) 0.5 0.5 mL

MgCl2 (1M) 1 1 mL

HEPES 10 2.8g

Total n/a 1000 mL
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CRITICAL: Adjust the pH of both 0.5- and 2.5-Ca2+ mM HEPES solutions to 7.4 with NaOH

and adjust the osmolarity to 278 with 5M NaCl or H20. Solutions can be stored in auto-

claved glass bottles at 4�C for several weeks, although it is preferable to make them fresh

every other week as the osmolarity can change during storage via evaporation and conden-

sation. On the day of the experiment, add glucose to final concentration of 10 mM (0.18 g/

100ml) and oxygenate the solution by bubbling with oxygen. The osmolarity of HEPES so-

lution after adding glucose is about 288–290.

Alternatives: Not Applicable.

CRITICAL: Adjust pH to 7.4 with CsOH and osmolarity to 278 with 5M NaCl or H20. Solu-

tions can be aliquoted and stored at �20�C for several weeks. Keep the solution on ice

throughout the experiment.

STEP-BY-STEP METHOD DETAILS

Prepare reagents and pipets

Timing: 30–60 min, on the day of experiment

1. Add 10 mM glucose to 0.5 and 2.5 mm Ca2+HEPES solutions and oxygenate them.

a. Refer to Materials and Equipment section for buffer recipe.

b. Use 0.5 mM Ca2+ HEPES for bipolar cell isolation and 2.5 mM Ca2+ HEPES for voltage-clamp

recording.

2. Reconstitute RBP-Cy5 peptide in pipet solution and load into filler pipet.

a. Dilute 1.4 mL of the 2.5 mM Cy5-RBP stock with intracellular/pipet solution (100 mL) (prepara-

tion step 4) to a final working concentration of 35 mM.

b. Load diluted solution into filler pipet

Note: Protect the loaded filler pipet from light by wrapping it in a piece of aluminum foil and

place it in a covered ice box.

2.5 mM Ca2+ HEPES (Recording solution)

Reagent (stock concentration) Final concentration (mM) Amount

NaCl (3M) 120 40 mL

KCl (1M) 2.6 2.6 mL

CaCl2 (1M) 2.5 2.5 mL

MgCl2 (1M) 1 1 mL

HEPES 10 2.8 g

Total n/a 1000 mL

Intracellular/Pipette Solution

Reagent (stock concentration) Final concentration (mM) Amount

Cs-gluconate (2 M) 120 1.5 mL

TEA-Cl 10 41.25 mg

HEPES 20 119 mg

MgCl2 (1M) 3 75 mL

NMDG-EGTA (0.2M) 0.2 25 mL

Na2-ATP 2 27.55 mg

Na-GTP 0.5 6.64 mg

Total n/a 25 mL

ll
OPEN ACCESS

STAR Protocols 3, 101107, March 18, 2022 9

Protocol



3. Prepare patch-clamp pipets

a. Prepare standard pipets.

b. Use <10 mU for bipolar cell soma, 10–15 mU for larger terminals (5 mm), or 15–20 mU for

smaller terminals (<3 mm).

c. Further details of the shape of the pipet can be found in the Pipette Cookbook from Sutter at

https://www.sutter.com/PDFs/pipette_cookbook.pdf

Note: Refer to the Materials and Equipment section for more information.

d. Coat the pipets with dental wax or other hydrophobic insulator to decrease stray capacitance

and improve noise characteristics.

i. Melt dental wax in homemade molten supply.

ii. Briefly dip and rotate the pipet in liquid wax to evenly coat the tip.

CRITICAL: Ensure that the wax coats the pipet from close to the tip to a point well past the

beginning of its taper but do not allow wax to enter the tip of the pipet.

Optional: Alternatively, the pipet may be insulated with Sylgard 184TM (poly-dimethyl

siloxane elastomer; PDMS) but as this requires a specialized apparatus, we use the dental

wax procedure described here instead.

e. Fire-polish the pipets using the microforge instrument.

i. Turn on the two LED lights in the microforge and set the heat/speed control to �6.

ii. Use the 603/0.6 objective to position the pipet so that both it and the platinum heating

filament are visible.

iii. Switch to the 103 long working distance plan achromatic objective to precisely position

the pipet tip against the polishing coil. The distance between the pipet tip and the filament

should be maintained at �75 mm.

iv. The polishing is controlled by a foot-pedal. We do a brief polishing by pressing the pedal

for a count of �3.

v. Store the prepared pipets in an air-tight container to prevent any dust particles that can

affect the formation of the seal.

CRITICAL: The quality of the prepared pipets is affected by the shape, appearance, and

position of the box filament, the age or freshness of the Drierite desiccant, the tempera-

ture of the room, and changes in air flow.

Localize single ribbon active zone and track a single SypHy molecule

Timing: 2 h/ retinal bipolar cell preparation, on the day of the experiment

4. Perform a whole cell recording and label the synaptic ribbon.

a. Secure the glass-bottom dish plated with bipolar cells firmly to the LSCM sample holder.

b. Select ocular mode to manually search for an intact rod bipolar cell using the LSCM’s 60 X sil-

icon objective lens and focus on the cell of interest using differential contrast to confirm that

the cell of interest is a healthy, intact bipolar cell suitable for the experiment. See Trouble-

shooting, problem 1.

c. Switch from ocular to LSMmode and use transmitter-detected channel to sharply focus on the

selected bipolar cell soma or terminal to facilitate patch-clamping. (Methods video S4)

d. To label the synaptic ribbon, perform a whole-cell patch camp recording from the cell terminal

with intracellular solution containing 35 mm Cy5-RBP. (Methods video S5)

e. Use a fire-polished, wax-coated glass pipet with a resistance appropriate for soma, large- or

small- terminals to obtain an access resistance of less than 20 mU.
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f. Carefully approach the soma or terminal of the selected cell with a brief positive pressure

applied via the mouthpiece attached to the electrode holder. Sharp focus on the edge of

the cell and the tip of the pipet before advancing the pipet toward the cell. (Methods video S4)

g. Release the positive pressure when an indentation forms in the plasma membrane and secure

the mouthpiece to prevent any movements during recording.

h. A successful whole cell recording requires a tight seal, so the seal resistance must be greater

than 3GU to proceed. See Troubleshooting, problem 3.

i. After establishing the whole-cell configuration, wait approximately 2–3 s for steady state la-

beling of synaptic ribbons.

CRITICAL: The labeling period for the synaptic ribbon will be longer when patching soma

or for higher access resistance (>30 mU).

CRITICAL: Fast scanning can be used during this process to minimize phototoxicity and

photobleaching.

5. In the FV 3000 software, select the dyes used for imaging and perform x-y and x-t line scan imag-

ing single SypHy molecule at a ribbon location molecule. See Troubleshooting, problem 4.

a. Zoom in on the cell terminal using the 603 objective and acquire x-y raster scans with a scan speed

of 2 ms/pixel (frame size, 2563 256 pixels) to monitor global SypHy responses to sustained depo-

larization. (Figure 1) In these experiments, the bipolar cell terminal is stimulated for 500-ms or for 1-

s at 30-s intervals. For analysis, we include terminals with leak current <20 pA.

Note: Use sequence manager in FV 3000 FluoView software and logic pulses between the

PatchMaster and Imaging computers to obtain x-y scans before, during, and after the stim-

ulus. See Troubleshooting, problem 5.

b. For tracking a newly fused SypHymolecule from a single active zone, we generate rapid x-t line

scans with a specific duration of a zoomed region through a selected ribbon to monitor SypHy

fluorescence. (Figure 2) Carefully adjust the focal plane to bring the labeled ribbons into sharp

focus to avoid the region of high curvature near the top of the terminal and the plane of adher-

ence of the membrane to the glass coverslip at the bottom of the terminal.

CRITICAL: Sharp focusing on the ribbon is important to minimize the impact of curvature

of the plasmamembrane in the z-axis within the optical section and facilitate localization of

the plasma membrane with respect to the ribbon.

Note: Single molecule imaging can be confirmed by PSF quantified by FWHM of a diffraction-

limited 27-nm fluorescent bead with the same imaging parameters. (Vaithianathan and Mat-

thews, 2014). Briefly, fit the bead image with two-dimensional gaussian fitting, which will pro-

vide a standard deviation (s) of the bead image. FWHM can be obtained using the following

equation FWHM = 2
ffiffiffiffiffiffiffiffiffiffi

2ln2
p

s. Due to the sparseness of SypHy expression in this zebrafish line,

the majority of experiments (94.4%) exhibit no detectable events. The signal to noise ratio

(SNR) can be improved by increasing the microscope’s pinhole size, as this will increase the

overall intensity of the emitted fluorescence.

Optional: Single molecule imaging and amplitude can be also confirmed with spontaneously

occurring events that can occur long after stimulation (>5s) or occasionally before depolariza-

tion as described in (Vaithianathan et al., 2019).

Pause point: The following data analysis steps can be performed on a later date.
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Data analysis

Timing: 0.5 h/dataset.

6. Analysis of the x-y scans.

a. Raw images acquired using the Olympus microscope running FV3000 FluoView software can

be opened in NIH ImageJ software (NIH, Bethesda, MD; https://imagej.nih.gov/ij/) using

Olympus viewer plugins that can be downloaded, as described in the Note below.

b. Position a square region of interest (ROI; 1 x 1 mm) at exocytic hotspots, which can be identified

by ribbon fluorescence. (Figure 1B, Top)

c. Use Image> Stacks> Plot z-axis profile to obtained spatially averaged SypHy fluorescence as a

function of time.

d. The recovery phase of SypHy fluorescence can be obtained by fitting the decay back to the

baseline phase with declining exponential using the curve fitting function in Igor Pro 8 soft-

ware (WaveMetrics, Portland, OR). The recovery phase, which presumably reflects the time

for internalization, acidification, and photobleaching, was exponential. (Figure 1B, Bottom)

Note: To open raw images acquired in Olympus requires Olympus ImageJ Plugin, which can

be downloaded from this link: https://imagej.net/formats/olympus. Instructions for installing

this plugin are also provided at this link.

7. Analysis of the x-t scans

Figure 1. SypHy fusion events in response to depolarization stimuli

(A) Retinal bipolar cells were isolated from transgenic zebrafish that highly express SypHy. The synaptic terminal was

patch clamped by using a whole-cell pipette filled with a solution containing fluorescent RBP to label synaptic ribbons

(red). Images show a single confocal optical section illustrating ribbon labeling with maximally expanded pinhole to

assay fluorescence throughout the terminal. Changes in SypHy fluorescence intensity, measured in a region of interest

during a 1-s (interval between stimuli=30-s) or in the absence of stimuli.

(B) Top: Changes in SypHy fluorescence intensity measured in a 1-mm2 square region centered on a single synaptic

ribbon before, during, and after in response to 1-s depolarization delivered at the arrow (see bottom panel). Bottom:

Spatially averaged SypHy fluorescence as a function of time. The green line represents averaged SypHy fluorescence

across time and black is best fit to a declining exponential. The arrowhead indicates the onset of the 1-s depolarizing

stimulus.
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a. Use Olympus viewer to open x-t line-scan images. In the ImageJ software, average the x-t im-

ages over 2 pixels in the x-axis and 5 lines in the t-axis using the Scale command on the Image

menu. This will optimize the SNR and quantification of RBP and SypHy fluorescence. (Figures

2B and 2C)

b. Analyze the x-axis profile of the x-t line scan to determine the spatial profile of SypHy fluores-

cence with respect to the ribbon. This can be obtained using ImageJ and Igor Pro8 software,

as follows.

i. Use the rectangular option in ImageJ to draw a ROI encompassing the entire line-scan.

(Figure 3A)

Note: Do not continue the analysis if the ribbon profile demonstrates any movement along

the time axis and/or bleaching.

Figure 2. High spatiotemporal resolution imaging of a single SypHy fusion events at single ribbon location in

response to depolarization stimuli

(A) Top: Synaptic terminals of retinal bipolar cells from transgenic zebrafish that sparsely express SypHy were voltage

clamped by placing the patch pipette filled with Cy5-RBP. We generated rapid x-t line-scans at a ribbon location to

obtain high spatiotemporal images of SypHy fusion events. We chose the ribbons that are sharp focused (For example

1, 2 or 5) and at the edge of the plasma membrane to generate line-scan. Bottom: x-t line-scans (white dash lines) were

obtained across the ribbon, perpendicular to plasma membrane.

(B) Left: Representation of a raw x-t raster plot of SypHy (green) and ribbon (red). The line-scans were obtained at

7.44 ms/line consisting of 2000-line scans. Right: TTL trigger from Patch Master computer delivered to the imaging

computer to start image acquisition. In addition, horizontal-scan synch from imaging computer is delivered to Patch

Master to obtain precise timing of image acquisition. Besides, voltage command, information about calcium current

and capacitance measurements for each stimulus also can be obtained from Patch Master computer.

(C) To enhance the SypHy fluorescence signal and optimize the SNR the same line scan in Figure 2B but averaged 2-

pixels along x-axis and 5-pixels along time-axis.
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ii. Go to Analyze > Plot profile.

Note: As standard orientation for analysis, we keep the outside of the cell on the right-hand

side. For images that were acquired with the ribbon on the left-hand side, flip both channels

horizontally, as follows. Go to Image > Transform > Flip Horizontally.

iii. Click the list in the bottom panel of the line profile to view the plot values.

iv. Go to Edit > Select All > Copy.

v. Open Igor Pro 8 software and go to Window > Select New Table > Paste.

vi. In Igor Pro 8, go to Windows > Select New Graph and assign gray values for Y waves and

distance as X waves.

vii. Fit x-axis intensity profiles with the equation f(x) = s(x) + g (x) (Vaithianathan et al., 2016), where

s(x) is a sigmoid function that describes the transition from intracellular to extracellular back-

ground fluorescence at the edge of the cell, given by s(x) = b- (c/(1-exp((x1/2-x)/d))), and g(x) is

a Gaussian function representing the fluorescence of RBP and SypHy, given by g(x) = a (exp

(-(x-x0)
2/w2)). The parameters x1/2 and x0were taken as the x-axis positions of the plasmamem-

brane and the fluorescence emitter, respectively. The parameter b is the intracellular back-

ground fluorescence, c is the extracellular background fluorescence, d is the slope factor of

the sigmoid function, a is the peak amplitude of emitter fluorescence, and w is O2* the stan-

dard deviation of the Gaussian function. In practice, the latter parameters were highly con-

strained by the data or by the measured PSF, essentially leaving only x1/2 and x0 as free pa-

rameters in the fitting. (Figure 3B)

Note: New fit functions can be entered in the Igor Pro 8 Curve Fitting panel under Function

and Data.

viii. We identified 81 putative SypHy events out of 1453 x-t line scans in response to sustained

depolarization from different ribbons (Figure 4C). (Vaithianathan et al., 2019) The control

experiment was performed by acquiring x-t line scans in the absence of depolarization

(named as null events). Single SypHy molecule fluorescence can be confirmed by imaging

a fixed single GFP molecule (Vaithianathan et al., 2019).

Note: Since cells from the SypHy zebrafish line express SypHy sparsely, the success rate of

obtaining SypHy fluorescence occurs with low probability (5.6%).

c. Analyze the time-axis profile of the x-t line scan to determine the temporal profile of SypHy

fluorescence with respect to the ribbon and to obtain the kinetics of the SypHy event. This

can be obtained using ImageJ and Igor Pro8 software, as detailed below:

i. Scale the time profile (X axis) with appropriate information. Reorient the x-t scan as demon-

strated in Figure 3C and obtained the temporal profile (Figure 3D) as indicated in Fig-

ure 3C.

ii. Event amplitude: The difference between baseline amplitude and peak amplitude is

defined as the event amplitude. The baseline can be determined by averaging the fluores-

cence obtained immediately before the depolarization. The timing of depolarization and

amplitude of calcium current can be obtained from the Patch Master software. To measure

the so-called peak amplitude, we identified the maximum value that occurred early during

the SypHy event and averaged 5 points centered around the peak. (Figure 4A)

Note: Single molecule amplitude can vary, depending on where the event occurred. Because

the z-axis thickness of our optical section was appreciable on the scale of our x-y image, one

concern was that SypHy fusion events in the z-axis could provide variable event amplitude for

the fusions that occurred at the top of the ribbon or the bottom of the optical section. To

define the smallest event amplitude, we randomly chose 203 out of 1372 null events and
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measured ‘‘event amplitudes’’ by taking the difference between the average fluorescence

immediately after the depolarization and at the baseline, averaging 5 measurements. To eval-

uate the imaging noise, we follow the same approach to measure SypHy and nulls except that

noise measurements were made in the absence of a stimulus.

iii. Dwell time:We observed that SypHy events remained at ribbon locations before declining

to baseline. We defined the period during which they remained visible as the event dura-

tion or dwell time. We quantified dwell time by measuring the duration of fluorescence be-

tween the time of the SypHy event and the time at which fluorescence declined to 1s (68%

of event amplitude). (Figure 4B)

iv. Ensemble averages: To analyze the properties of SypHy clearance, we categorized events

as described below and averaged each group by synchronizing them with the event onset.

To compare the SypHy events that occurred at different times after depolarization, we

grouped the events as those that occurred within 30 ms of the start of depolarization (burst

events) and those that occurred after 500 ms (sustained events). For a locus of fusion with

respect to the ribbon, we grouped SypHy events based on their locations relative to the

center of the ribbon in the x-dimension (x0 as defined above). SypHy events that occurred

at x0 > 50 nm were classified as membrane proximal events, while those that occurred at x0
% 50 nm were classified as membrane distal events.

v. We obtained averages of ensemble events to compare between different categories and

established a Monte Carlo simulation of a molecule undergoing a 2D random walk illumi-

nated by a line scan. Please refer to Vaithianathan et al. (2019) for more details.

EXPECTED OUTCOMES

In our experimental protocol, we used adult zebrafish that sparsely express SypHy from an HSP70 pro-

moter to track the clearance of fused synaptic vesicle proteins from isolated retinal bipolar neurons (Vai-

thianathan et al., 2016). Fluorescently labeled RBP was used to localize the ribbon active zone and two-

color Laser Scanning Confocal Microscopy allowed simultaneous imaging of SypHy and RBP fluores-

cence.We adjusted scan speed and laser settings to optimize the signal-to-noise ratio (SNR) and tomini-

mize photobleaching of the fluorophores. To increase the spatiotemporal resolution, we performed x-t

line scans across the ribbon active zone, perpendicular to plasmamembrane. The timing of imaging and

depolarization was synchronized by exchanging logic pulses between the patch-clamp and imaging

computers that were running Patch Master and FluoView FV3000 software, respectively. We confirmed

single molecule imaging with a single GFP molecule and fluorescently labeled 27 nm beads (Vaithiana-

than et al., 2019). Using this approach with the sparsely expressing SypHy zebrafish line, we were able to

detect single SypHy molecule fluorescence reliably during and after fusion from a single ribbon active

zone, thus allowing us to study the kinetics and location of vesicle fusion with respect to the ribbon

and clearance of a single SypHy molecule after fusion.

Previous work suggested that bipolar ribbon synapses exhibit kinetics of neurotransmitter release in

response to step depolarization. Indeed, our ability to fit these known kinetic components of release

with capacitance measurements from the cumulative histogram of the onset of SypHy events allows

us to confirm that the individual SypHy events we observe in these experiments represent the fusion

of single synaptic vesicles (Please see Figure 3B, (Vaithianathan et al., 2019). Our data also provide

direct demonstration that the majority of the SypHy events we observed occur with fast release ki-

netics, where the SypHy-containing vesicles that fused within 30 ms of depolarization were proximal

to plasma membrane. However, SypHy events with slower kinetics that fused after 500 ms of stim-

ulation exhibit no obvious relationship between the timing of the event and their location.

Furthermore, our approach allowed us to reveal the dynamics of fused synaptic vesicle proteins at a

single ribbon active zone. We observed an abrupt increase in SypHy signals that represented
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exocytosis of a single vesicle. The increase in fluorescence remained at the synaptic ribbon active

zone for some time before returning to the baseline. Quantification of this period, which we refer

to as dwell time, revealed that event duration was approximately exponentially distributed with a

time constant of 340 ms.

We also found that fluorescent decay of individual SypHy events varied considerably, as expected

for the stochastic behavior of individual molecules. Our experiments confirmed that the decay of

SypHy events reflects diffusion of individual SypHy events out of the scan region rather than inter-

nalization, reacidification, or photobleaching. To determine the dynamics of fused vesicle protein

clearance, we first categorized the SypHy events into those events that were based on time relative

to depolarization and those events that were based on location of fusion relative to the ribbon-active

zone. Next, to define the impact of timing on vesicle clearance, we compared ensemble averages of

Figure 3. Analysis of x-t line-scan of Single SypHy fusion events at a ribbon location

(A) Spatial intensity profile (x-axis profile) of SypHy fusion event with respect to ribbon (RBP) is obtained from line-scan

averaged to optimized for SNR. The ROI, the area between the two-white dash lines, was used to obtain the x-axis

profile.

(B) Spatial (x-axis) intensity profile of x-t raster scan of SypHy (green) and RBP (red) in A. The green dash line is centroid

(x0) of the Gauss decline fit of the SypHy fluorescence and red dash line is plasma membrane position (x1/2) of the

Gauss decline fit of the RBP fluorescence. The black dash lines are G 1 s of the centroid (x0) and were used to define

the ROI in lower scan in C (white dash line).

(C) Temporal intensity profile (time-axis) of RBP and SypHy fluorescence intensity is obtained by reorienting the x-t

scan as indicated by the arrow (top). Here the time-axis is updated with appropriate scale.

(D) Temporal intensity profile of the SypHy fluorescence over a region of interest shown in C. Arrowhead indicates the

onset of the 1-s depolarizing stimulus.
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the SypHy events that occurred within 30 ms of depolarization (burst phase) and those that occurred

up to 0.5 s after depolarization (sustained phase). We used Monte Carlo modeling to test whether

simple diffusion could explain the decay rate for ensemble SypHy events. The only free parameter

in the simulation was the step size, which is the diffusion coefficient of the stimulated molecules. We

allowed this value to vary to best fit the data. The burst events were best fit by a diffusion coefficient

of 41.2 nm2/ms, whereas sustained events were best fit with a diffusion coefficient of 9.6 nm2/ms

(Please see Figure 6, (Vaithianathan et al., 2019). Therefore, our data suggest that clearance of fused

vesicle proteins for brief events were faster than the sustained events. We followed the same

approach to determine ensemble averages of SypHy events that fused to distinct locations within

the ribbon active zone to determine whether the exact location of the fusion event influenced the

Figure 4. Kinetic parameters of single SypHy events

(A) Example of averaged temporal intensity profile of SypHy fluorescence intensity. Event amplitude is measured

between ‘‘peak’’ amplitude of SypHy event and the baseline. The peak amplitude is defined by averaging 5 points of

maximum value that occurred early during the SypHy event (red dash line indicates start of SypHy event), and baseline

is the average fluorescence obtained immediately before depolarization. The voltage protocol shown at the top (red).

(B) Dwell time is the duration of SypHy events remain at fusion sites with different durations before declining to

baseline fluorescence. Dwell time is quantified by measuring the duration between the time of SypHy event

occurrence (red dash line), to fluorescence decline to 1s (68%, black solid line) of event amplitude (black shades).

(C) Histogram of the event of the 81 SypHy events as shown before in original publication (Vaithianathan et al., 2019)

Figure 3B (Inset)
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rate of clearance from the active zone. We found that the dwell time of proximal SypHy events were

twice as fast as those of distal events. When we used best-fit Monte Carlo simulation to estimate

apparent diffusion coefficients, the best fit model suggested that proximal events occurred faster

(49nm2/ms) than did distal events (16.1 nm2/ms).

Our direct approach of imaging single vesicle in conjunction with capacitance measurement and

tracking clearance of fused vesicle protein provides a valuable tool that can be combined in the

future to explore the factors that govern clearance of fused synaptic vesicles and other aspects of

vesicle dynamics.

Statistical methods

No statistical method was used to predetermine sample size. Variance in estimates of the population

means were reported as a standard error of measurement (SEM). Statistical significance of differ-

ences in average amplitudes of rare and evoked events were assessed using unpaired, two-tailed

t tests with unequal variance.

LIMITATIONS

Tracking the dynamics of single fused synaptic vesicle proteins from a single ribbon active zone

described in this protocol requires optimizing parameters to monitor a single SypHy molecule at

a single synaptic ribbon active zone in a living neuronal terminal for several seconds. The limitations

to obtaining such measurements are governed by several factors: optimizing the optics of the micro-

scope, the health of the neuron, the incorporation of the transgene into viable zebrafish, the stability

of the system, and the trade-off between the signal-to-noise ratio (SNR) and photobleaching.

TROUBLESHOOTING

Problem 1

Number of isolated bipolar cells are low/absent.

Potential solution

Optimize the steps for dissecting the retina. The health of the retina affects the number and quality of

the cells.

If undigested pieces of the retina remain after digestion or if there is a preponderance of photore-

ceptor cells, the problem may be that the retina is not digested enough. In this case, increase the

number of units of papain and/or increase the duration of digestion.

Conversely, if the overall cell population is low and the cells appear to be extremely flat with pores or

a rough-appearing surface, the retina may be over-digested. In this case, decrease the number of

units of papain and/or reduce the duration of incubation.

Bipolar cells are extremely sensitive to pH and osmolarity, so it critical that the HEPES buffer and all

the solutions are freshly prepared.

Trituration to release the bipolar cells from the retinal tissue must be performed carefully and

without producing any bubbles. The bore size of the triturating pipet should be only a little smaller

than the piece of retina to be triturated.

Ensure that the coverslip of the recording chamber is clean before plating the cells.

Problem 2

Vibrations observed by imaging a fixed fluorescent bead.
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Potential solution

Vibration on the isolation table can occur if the balance is not well centered. Cables hanging off the

table can make a physical connection and transmit vibration to the table. To isolate individual instru-

ments, use flexible cables and allow them to hang loose. In addition, the airflow in the room can also

contribute to vibration. In such instances, adjust the strength or direction of airflow.

Problem 3

Unable to obtain tight seal with the patch clamp pipet.

Potential solution

Obtaining the required giga-ohm seal depends on the osmolarity of the glucose-containing

recording solution (288–290 mOsm) and the intracellular/pipet solution (�278 mOsm). Ensure

that the osmolarity of these solutions is correctly adjusted with 5M NaCl or DI H2O. Generally, a

good seal is obtained when the intracellular/pipet solution is prepared with lower osmolarity than

the recording solution.

If the isolated cells are too rigid or not intact, the isolated cells may have questionable health. In this

case, please follow the solutions recommended for Problem 1.

Formation of the seal can also be affected by the pipet shape and size or by over-polishing of the

pipet. Follow the recommendations in the protocol for desired pipet resistance for soma and for

different sizes of cell terminal and optimize further.

Filter the intracellular pipet solution to remove any debris. Check the fittings of the mouthpiece and

the electrode holder to ensure that the system can establish and hold positive pressure. Keep the

pipets covered until use to ensure that they stay clean and free of debris.

Problem 4

Establishing laser parameters for imaging a single SypHy molecule.

Potential solution

To establish the confocal parameters for imaging a single SypHY molecule, use immobilized GFP

(488 nm). Laser settings for RBP (647 nm) can be determined empirically by loading the cells with

RBP via a patch pipet.

Problem 5

Poor calcium current.

Potential solution

The current is dependent on the health of the bipolar cells. Follow the recommendations for ad-

dressing Problem 1.

Prepare a new batch of solutions to ensure that they are correctly prepared and that their pH and

osmolarity are adjusted correctly.

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Dr. Thirumalini Vaithianathan (tvaithia@uthsc.edu).

Materials availability

Details of the transgene can be obtained from (Vaithianathan et al., 2016) and https://zfin.org/

action/feature/view/ZDB-ALT-160602-11#summary.
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Data and code availability

Data and codes are available from the lead contact upon request as well as from the original publi-

cation by Vaithianathan et al. (2019).

SUPPLEMENTAL INFORMATION

Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2021.101107.
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